
This document provides informa�on on how to request 
and review edits to the Vermont Significant Wetlands Inventory (VSWI) for public no�cing.  Individuals 
from mul�ple programs are aiding in the edi�ng of the VSWI.  Those individuals crea�ng edits are called 
Editors throughout the document. 
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Vermont Significant Wetlands 
Inventory Edit Instructions 



 

Vermont Significant Wetlands Inventory Overview  
The Vermont Significant Wetlands Inventory layer (VSWI), is the Wetlands Program’s inventory of known 
regulated wetlands (Class I and Class II).  The layer was first created in 1990 from a copy of the Na�onal 
Wetlands Inventory.  In 2010, the inventory was updated with changes to the Na�onal Wetlands Inventory 
and in 2012 the Program was given the ability to reclassify wetlands and modify the VSWI accordingly.  The 
Program did not regularly start making edits to the VSWI un�l 2018, and those edits were primarily 
polygon addi�ons rather than edits to exis�ng polygons to improve the extent and loca�on of the known 
wetland.  Many wetlands that are Class II are not on the VSWI, which causes confusion amongst the 
regulated community.   

The Wetlands Program started contrac�ng professionals to update wetland mapping using aerial 
interpreta�on in 2018 and is scheduled to have a statewide update completed by 2025.  These edits are 
important for catching many wetlands that have not been previously iden�fied, but will not capture many 
wetlands at the project scale.  This is why the Wetlands Program is s�ll commited to adding wetlands to 
the maps on and project by project basis.  Currently, the Program is focusing project-specific edits for 
projects involving permits.  Focusing on permited projects allows us to ensure that wetlands with 
proximate human ac�vi�es are iden�fied on the VSWI.   

VSWI Edit Dashboards  
The map edits dashboard includes lists of the map edits that are underway.  This dashboard only includes 
those edits that were entered into the database in 2021 to present.  Those edits on the Admin Incomplete 
list need applica�on review.  Projects on the “not mapped or needs edit” list need mapping work in the 
VSWI edits layer.  These are on the list to draw onto the VSWI edit layer for the first �me or because the 
Ecologist reviewed the drawing and has addi�onal edits.  The determina�on descrip�on field includes 
informa�on on next steps.  Projects that are ready to be drawn have in the determina�on descrip�on the 
wetland cover type (eg. PEM1), delinea�on date, and indica�on that the shapefile is in the project folder 
or on the Advisory layer (eg. “shapefile in folder”).  Staff assis�ng in dra�ing edits are assigned to projects 
with their names in the determina�on descrip�on.  If Editors are finding their list of assignments are low, 
they will inform the Lead Editor to receive more assignments.   

http://anrgdb:6262/ReportServer?/DEC/WSMD/Wetlands/Admin/WetlandsMapEditDashboard&rs:Command=Render_blank


 

The wetlands determina�ons with no final date, applica�on received prior to 1/1/21 is a list of wetlands 
added into the database prior to 2021.  This is our backlog list from before we had the capacity to add 
wetlands to the VSWI that are associated with permits.  These are lower priority than the previously 
men�oned list.  Staff working on this list will be given specific instruc�ons.  Not all wetlands on this list 
may be categorically Class II, many do not have shapefiles, and may need addi�onal work before they can 
be added to the VSWI edit layer.     

 

Use of ArcGIS Pro and AGOL 
VSWI Editors will use an ArcGIS Pro project to import shapefiles/geodatabases and edit the VSWI Edit layer.  
They will not create a separate AcrGIS Pro project for each polygon/wetland project.  Arc GIS Online (AGOL) 
will not be used to create or edit polygons in the VSWI edit layer because edits do not always properly 
save when mul�ple people are working on the same layer in AGOL.  District Wetlands Ecologists will use 
AGOL to view VSWI Edits for review.   

For instruc�ons on how to set up an ArcPro project and refresher on adding and edi�ng layers, see 
Appendix A.   

 

Data for Polygon Creation 
All VSWI edits requested/added a�er 2021 will have a shapefile or geodatabase to copy/paste from in the 
project folder.  Some requests may be on the list before the shapefile/geodatabase is added.  All projects 
with an available shapefile will include a note in the determina�on descrip�on field (eg. “shapefile in 
folder”).  Most o�en the shapefile will be in the decisions folder as a zip folder.  If the applicant provided 

Use this column to find 
assignments, shapefile,  

edit notes, and atribute 
informa�on. 

http://anrgdb:6262/ReportServer?/DEC/WSMD/Wetlands/Admin/DeterminationsReceivedPriorJan2021&rs:Command=Render_blank


the shapefile, it may be in the Administra�vely Complete folder.  Editors should not begin the crea�on of 
a polygon in the VSWI edit layer unless there is a shapefile in the folder.  

Editors may at �mes need to request a new shapefile, if for example it does not project properly on the 
map (e.g. appears on blank background), or if it is a par�al line file. Par�al or line polygons should be ok, 
if the Editor is confident determining where the wetland boundary should be (you may be able to use Lidar 
and the Advisory layer as guides to determine where the wetland extends to). Editor should reach out the 
Lead Editor or Program Editor if they need assistance figuring out where the wetland boundary is. Reach 
out to Lead Editor if a new shapefile is needed, so the Lead Editor can request one from the consultant. 

VSWI edits requested/added before 2021 may or may not have a shapefile.  These may require the Editor 
to create an edit based on site plans or sketches.   

 

Polygon Creation Guidance 
In general, Editors should use the polygon drawn by the DWE (district wetland ecologist) or 
shapefile/geodatabase in the Admin Complete file from the consultant. In some cases, the consultant 
shapefile may be a small sliver of the wetland with an “open end” with no defined boundaries where the 
wetland continues. The open-ended features can be distinguished by a flat end to a polygon that 
matches a property line or the side of a wetland polygon in the perfect shape of an arrow.  Linear 
projects (eg. Powerline, road corridor) often show wetlands ending at the extent of their Right-of-Way 
(ROW).  The Editor may complete the open ends of wetland boundaries freehand by using Lidar or other 
layers to inform their mapping (to “see” the wetland), to create a more logical boundary.  Whatever is 
not an “open end” needs to be followed exactly.  The extent of freehand allowed is dependent on the 
edit type in the database. Edits (Type “VSWI change”, “VSWI removal”) must remain contained within 
the project parcel boundary unless there are no permit applications in the file.  It would be reasonable 
to end a polygon at the extent of a cover type (eg. map a marsh to the tree line but not into the forest). 
You may wish to get guidance from the DWE before extending the open end.  Where you are unsure or 
otherwise want DWE guidance, map only what is from the files provided, check “mapped” in the 
database and add text in “Description” field to request their guidance. It is OK if the wetland is factually 
bigger than what is added to the VSWI.  Some mapped wetland is better than none, after all.   

Polygon drafting guidance by edit type 

The variety of different public noticing requirements for the different edit types means that the polygon 
drafting needs to follow guidelines dependent on the edit type.   Failure to follow guidance may result in 
an edit that did not provide the public due process and can be contested in court1.  Guidance by edit 
type is provided below. 

General Determinations (Type Class III to Class II): These cannot be connected to any existing 
VSWI polygons.  If there is a connection to an existing VSWI polygon, then the edit needs to be a 
“VSWI Edit” type.  Contact the DWE by checking the “mapped” box and adding a note in the 
description field in the database.  Polygons may extend past the project’s parcel boundaries but 
should not go beyond where the DWE viewed the wetland (seen from roads, parcel boundaries, 
vegetation signatures from aerial match community types seen in field).  You would only know this if 

 
1  Very few VSWI edit decisions have been appealed and only one has gone to court. 



you asked the DWE.  DWE have instruction to not go beyond what they viewed, but you may want 
to have them confirm if they are asking for a very large area. The DWE may like to extend it further 
but will need to keep the edits contained to what is defensible in court.   

VSWI Changes with permit: VSWI changes are for existing VSWI polygons.  If the VSWI change is 
for a file that has a permit application on record, the VSWI change cannot extend beyond the 
project parcel.  For ROW projects, the Editor may map onto the parcels associated with/ adjacent to 
the ROW but not beyond, as only adjoining landowners were provided notice of the activity.   

Edits should be accomplished by changing the existing VSWI polygon rather than creation of an 
additional polygon that touches the existing VSWI, unless that addition is a separate cover type (eg. 
VSWI is PFO and the addition is PEM).  This will allow the DWE to keep track of the original adoption 
date of the VSWI for potential enforcement or legacy purposes.  There are two ways to do this: 1) 
copy/paste the VSWI polygon into VSWI Edits layer and make edits from there (move vertices or 
draw overlapping polygon and merge); 2) if the edit is drastically different it may be simpler to draw 
an entirely new polygon and copy/past just the attributes from the original VSWI polygon.  Ryan will 
be creating a demo video for assistance. 

VSWI Changes, no permit:  Follow the same guidelines as “VSWI changes with permit” above, but 
the Editor may map beyond the project parcel but should not go beyond where the DWE viewed the 
wetland (seen from roads, parcel boundaries, vegetation signatures from aerial match community 
types seen in field). 

Individual Determination (Type: “Class III to Class II”, ‘send to ENB’ box checked): These can be 
connected to existing VSWI polygons.  Polygons cannot extend beyond the project parcel’s 
boundaries. 

Adding Attributes to Polygons  
The VSWI contains various atributes to aid in keeping track of edits, approval process, and basic 
informa�on about the wetland.  The following tables explain the various fields in the atributes table of 
the VSWI edit layer and how the Editor should fill the fields.   

Field Name Descrip�on What to do 
NWI Code Na�onal Wetlands Inventory Code Enter code from determina�on 

descrip�on field if it is there, otherwise 
leave it blank for DWE to fill out. See 
chart and table in appendix B for more 
informa�on about the codes. 

LLWW Landscape posi�on, Landform, Water flow 
path, and Waterbody type code.   

Leave blank. This is informa�on 
provided by watershed-wide efforts 

VSWI Class Wetland classifica�on Always add the intended final 
classifica�on. 

Adop�on date Date of determina�on decision or map 
correc�on/revision decision date  

Leave blank in edit layer.  Will add 
adop�on date once final decision is 
issued.   

Mapping 
Organiza�on 

Organiza�on that created the map Use VT Agency of Natural Resources.  
Fills out automa�cally. 

file://vtanr/docs/WSMD_Wetlands/Templates%20&%20Intructions/Reference%20Materials/Classification-of-Wetlands-and-Deepwater-Habitats-of-the-United-States-2013%20(1).pdf


Issue mapping 
change 
authority 

Lists reasons in Rule for the edit or 
addi�on of the polygon. 

Must be filled out based on 
“determina�on type” in database.  See 
“issue mapping change” table below 
for further instruc�ons.   

Poten�al map 
changes 

For dra� work that isn’t called out in the 
database and we need to study further to 
learn our authority to add. 

Leave blank 

Mapping Date The date you drew the map on the layer 
OR date the delinea�on or digi�zing took 
place. 

Date is included in determina�on 
descrip�on field by Ecologist  if nothing 
in the field, leave blank for DWE to 
write in. Date informa�on was 
collected, if mapping method is field 
related or when map was created if 
digi�zed from screen.  

Program file 
number 

Program file number Must be filled out.  Add file number 
from the database. 

Vegeta�on 
Assemblage 

Open field for describing the vegeta�on 
cover. 

Leave blank 

Status Status of map change Must be filled out.  Should default to 
pending. 

Notes Open field.  Public can view None required.  Can add where the 
delinea�on file was from (consultant 
name), but not required. 

Internal Notes Notes to add that are not public.   Leave blank 
Acres Size of wetland polygon Leave blank  (field autofills) 

 

 

Issue mapping change authority op�ons Reason to use 

�� General Determina�on Type: “Class III to Class II” and not checked in 

“Send to ENB”.  You’ll use this one the most. 
Sec�on 8.5biii Mapping Correc�ons - delinea�on Type: “VSWI changes with Permit” and we have a 

delinea�on shapefile. 
Sec�on 8.5bii Mapping Correc�ons – con�guity Type: “VSWI changes”. When we are adding area 

to a wetland. 
Sec�on 7 – Rule Making Pe��on Type: “Class II to Class I” Class I Only.   
Sec�on 8 Determina�on – Buffer zone adjustment Type: “Buffer zone adjustment” Change in buffer 

zone width 
Sec�on 8.5a Mapping Correc�ons – polygon 
dele�on 

Type: “Removal” or “Removal with permit” For 
polygons created of area to be deleted. The 
polygon will not ul�mately be added to the VSWI, 
but will be used to guide the clipping of the 
exis�ng VSWI once approved.  Vgj` 

Sec�on 8.5bi Mapping Correc�ons – registra�on 
error 

For polygons that need to be shi�ed to the side to 
overlay on feature in aerial.  Seldom used. 

Sec�on 8 Determina�on – Class III to Class II Type: “Class III to Class II” and “Send to ENB” 
Checked.  Formal individual determina�ons only.   



Sec�on 8 Determina�on – Class II to Class III Type: “Class II to Class III” 
Sec�on 4.6 presump�on – Map Addi�on N/A 

 

Database Entry for Ecologist review 
Once the dra� VSWI polygon has been created/edited, you may now request District Ecologist Review 
through the database.  If there are mul�ple wetlands associated with the edit, make all edits before 
changing the database.   

 

Go to the Determina�on tab within the project in the database and select the edit you have completed.  
Add an administra�vely complete date and check the “mapped” box.  This will move the edit from the 
administra�ve list of edits to the list on the District Ecologist’s dashboard. 

If the Ecologist cannot approve the polygon(s), they will add a note in the determina�on descrip�on with 
the edits needed and uncheck the “mapped” box to place the edit back on to the administra�ve list (“not 
mapped or needs edit” list).  If the edit is approved by the Ecologist and the edit is not an individual 
determina�on, the Ecologist will add a technically complete date.  If the edit is an individual determina�on, 
the Ecologist will add a tech complete date, uncheck “mapped” and check “send to ENB” (if not already).  

District Wetland Ecologist Review 
Once the polygon(s) are created for a project and the mapped box is checked in the database, the 
District Wetlands Ecologist will review the polygon and atributes for accuracy.  Ecologists will primarily 
complete these review when other work is less pressing and will have the most �me to review during the 
months of November-March.     

Loca�ng a polygon on VSWI Review layer 
Once the VSWI polygon is created, you will be able to search for it at any �me on the VSWI Review map 
(web-based copy of the Edit layer) using the wetland project #.  This is the primary way the District 
Wetlands Ecologists will review the dra� maps.   

Navigate to the VSWI Review map: 
htps://vtanr.maps.arcgis.com/apps/mapviewer/index.html?webmap=b4d12ade774144a7b83df146b8b
27131 

https://vtanr.maps.arcgis.com/apps/mapviewer/index.html?webmap=b4d12ade774144a7b83df146b8b27131
https://vtanr.maps.arcgis.com/apps/mapviewer/index.html?webmap=b4d12ade774144a7b83df146b8b27131


Click on the magnifying glass on righthand side of the map window: 

 

Click the down arrow and select “VSWI Review: Program file number” 

 

Type the project number in the search bar and hit Enter. You will be zoomed to the loca�on of the wetland 
polygon. Here, you can also review the atributes associated with the polygon: 



 

 

Moving approved VSWI edits to the official VSWI (lead Editor only) 
This is completed by the Lead Editor only.   

 

Appendix A: Starting an ArcPro Project and polygon edit basics 
First you will need to open and sign into ArcPro (desktop app) using your username and password.   

The picture below is the screen of Arc a�er you sign in. If this is your first �me using ArcPro, create a new 
project/map. Otherwise, open your desired project by clicking Open on the far le� and then view your list 
of recent projects: 



 

Adding data layers to a new project 
If you’re star�ng a brand-new project, you’ll need to add several data layers to it before you can begin 
mapping. Note: You can import layouts, maps and other files from the Project tab (see screenshot below). 
You can also find helpful map layers via the Portal tab (such as Town boundaries, parcel boundaries, Lidar 
layers, the VSWI Edit layer we will be saving all our edits to, etc.). Once you click on the Portal, you will see 
everything hosted under ‘My Content’. You can also click on the other icons (My Groups, My Organiza�on, 
etc.) to find layers you need. These layers can be added to your project by dragging them into the mapping 
window. The desktop app and ArcGIS Online are connected to share data easily. 

 

 

The Contents 
pane is the most 
useful way to 
visualize the data 
layers you have in 
your mapping 
project, and to 
see whether they 
are turned on/off 
(checking box 
toggles layer on). 
Note: The order 
of your layers 
maters as the 

layers that are on top will overlap the layers below. Below is a screen shot of a project file’s Contents pane. 



If you are crea�ng a new project, try to mimic the image below by adding the appropriate data to your 
project. 



 

Once you have your project set up, you are ready to start adding new polygons to the VSWI edit layer. 



Get template from AGOL to use in Arc Pro 
Navigate to ArcGIS Online (AGOL).  

Locate the “VSWI Review” layer by clicking on the Layers icon on the le� ribbon. Click the 3-dot icon to 
open the menu for that layer: 

 

Click on “Save As” to save the layer to the My 
Content library in ArcGIS 

 

A new window will appear, showing you that the layer will be saved to My Content. Click Save. 

https://vtanr.maps.arcgis.com/apps/mapviewer/index.html?webmap=b4d12ade774144a7b83df146b8b27131


 

You will then be able to import the 
layer into your project via the My 
Content library in ArcGIS. To find this 
library, go to Catalog > Portal > My 
Groups in ArcPro: 



 

To add the layer to your map, click and drag it into the map frame. You will see that it has been added to 
the Contents pane (le�hand side of screen): 

 

 



Adding and edi�ng polygons 
To add a new polygon to the edit layer, you will o�en need to import a shapefile (provided by either the 
wetland consultant or the ecologist- will be in the Y drive project folder) into ArcGIS. To import a shapefile, 
navigate to the Catalog pane (far righthand side of window), and click on the Project tab: 

 

To find your shapefile, click on the Folders branch and navigate to the folder where the shapefile is saved 
to your computer (in this example, the user has created an ArcGIS folder in Documents, and then a 
subfolder for shapefiles organized by wetland project #). Click the small triangle next to each subfolder 
un�l you open the shapefile itself, which will contain a polygon (has a litle green icon to the le� that looks 
like a puzzle): 



 

To import the shapefile into your map, click and drag it over into the mapping window. When you drag it 
over the top of your map, you’ll see a litle + sign in a white box, indica�ng that the shapefile is being 
added. Once you add the shapefile, you’ll see it in the Contents pane on the le�hand side of your map 
window: 



 

Right-click on the shapefile name in the Contents pane, and then click “Zoom to Layer” to zoom to its 
loca�on on the map: 



 

 

Now you can see that the shapefile is visible (light blue). You can modify the color of the shapefile if you 
wish, by right clicking it in the Contents pane and selec�ng Symbology. This most likely won’t be necessary, 
unless the color blends in with the background or you need to dis�nguish the shapefile from another 
mapping layer (ex: Advisory layer below is light green): 



 

You can now copy/paste the shapefile to your desired map layer (in this case, “EDIT LAYER VSWI” which 
we will use for all our wetland edits). First, select the shapefile by clicking the Select tool in the Edit tab: 

 

Draw a rectangle around the shapefile to select it. If you are unable to select the shapefile, you may have 
to change your selec�on se�ngs in the Selec�on tab of the Contents pane, which is an icon that looks like 
a puzzle. Click the checkbox next to your shapefile to make it selectable: 



 

Now you should be able to select the shapefile either by clicking it, or by drawing a rectangle around it 
(especially useful if the shapefile contains mul�ple polygons as in the example): 



 

Once selected, you can copy/paste the shapefile to the VSWI Edit layer. Right click on your selected 
shapefile and click “Copy” 



 

The shapefile is now copied to the clipboard. To paste it to your desired layer, select Paste and then Paste 
Special in the upper le�hand corner of the Edit tab. Choose the layer you wish to paste it to (VSWI Edit 
layer) and then click Ok: 



 

You will now see that the shapefile has been copied to the VSWI Edit layer. Save your edits early and o�en! 
To save your edits thus far, click on Save in the Edit tab (�p: if the Save icon appears in color, it means you 
have unsaved edits): 

 



Next, add atributes (see details and table in “Adding Atributes to Polygons” sec�on earlier in this guide) 
to the newly copied polygons by right clicking on the VSWI Edit layer and naviga�ng to the Atribute table. 
You will see the atribute table pop up in the pane at the botom of the screen: 



 

There are certain atribute categories that are required, and others that are op�onal or not needed (refer 
to “Adding Atributes to Polygons”). You can either edit atributes directly in the Atribute table at the 



botom of the screen (some fields are open text such as the Project File # or NWI Code, whereas others 
are dropdown), or you can add them by s�cking the Atribute table to the far righthand side of your screen. 
This op�on also allows you to Ctrl + click on mul�ple polygons and add atributes to mul�ple at once. To 
open the atribute table on the righthand side, click on the Atributes icon in the Map tab: 

 

You will need to pin the atributes pane to the righthand side of your screen by clicking the pushpin icon. 
You can then edit atributes for one or mul�ple polygons at a �me by ctrl + selec�ng them from the top 
menu: 



   

Edits that have NOT been reviewed by a wetland ecologist must have a “Pending” status (default). Use the 
Program file number field to enter the wetland project #. If you have ques�ons about atributes, refer to 
table in sec�on above, or ask another Editor. 

Once you’ve added atributes, save your edits again. It also doesn’t hurt to save your project so that when 
you come back to it, you’ll be zoomed to the same loca�on: 



 

 

Appendix B: Cowardin Codes 
The following chart is from Wetlands and Deepwater Habitats Classifica�on chart (fws.gov)  Note there is 
an addi�onal Water Regime code D for permanently saturated that has since been added a�er the chart 
was made. 

 

Na�onal Wetlands Inventory Code: 

Symbol Current Definition 
 P Palustrine 
 PUB Palustrine, Unconsolidated Bottom 
PUB1 Palustrine, Unconsolidated Bottom, Cobble Gravel substrate 
PUB2 Palustrine, Unconsolidated Bottom, Sand substrate 

https://www.fws.gov/wetlands/documents/Wetlands-and-Deepwater-Habitats-Classification-chart.pdf


PUB3 Palustrine, Unconsolidated Bottom, Mud substrate 
PUB4 Palustrine, Unconsolidated Bottom, Organic substrate 
PAB1 Palustrine, Aquatic Bed, Algal 
PAB2 Palustrine, Aquatic Bed, Aquatic Moss 
PAB3 Palustrine, Aquatic Bed, Rooted Vascular 
PAB4 Palustrine, Aquatic Bed, Floating Vascular 
PEM1 Palustrine, Emergent, Persistent 
PEM2 Palustrine, Emergent, nonpersistent 
PSS1 Palustrine, Scrub-Shrub, Broad-Leaved Deciduous 
PSS2 Palustrine, Scrub-Shrub, Needle-Leaved Deciduous 
PSS3 Palustrine, Scrub-Shrub, Broad-Leaved Evergreen 
PSS4 Palustrine, Scrub-Shrub, Needle-Leaved Evergreen 
PSS5 Palustrine, Scrub-Shrub, Dead 
PSS6 Palustrine, Scrub-Shrub, Deciduous 
PSS7 Palustrine, Scrub-Shrub, Evergreen 
PFO1 Palustrine, Forested, Broad-Leaved Deciduous 
PFO2 Palustrine, Forested, Needle-Leaved Deciduous 
PFO4 Palustrine, Forested, Needle-Leaved Evergreen 
PFO5 Palustrine, Forested, Dead 
PFO6 Palustrine, Forested, Deciduous 
PFO7 Palustrine, Forested, Evergreen 
Water Regime 
Modifier  NWI definition 
A  Temporarily Flooded 
B Seasonally Saturated 
C  Seasonally Flooded 
D Continuously Saturated 
E Seasonally Flooded/Saturated 
F Semipermanently Flooded 
G Intermittently Exposed 
H Permanently Flooded 
J Intermittently Flooded   
K Artificially Flooded 

Water regime modifier goes a�er the standard code (eg. PFO1D) 

Type Modifier Code NWI Defini�on 
a Acid 
i Alkaline 
g Organic soil 
n Mineral soil 
b Beaver influenced 
d Par�ally drained/ditched 
f farmed 
h Diked/impounded 



r Ar�ficial substrate 
s Spoil 
e Excavated  

Type modifier goes a�er the water regime modifier (e.g. PFO1Db) 

 

 

 

 

 

 

 

 

 

 

 



Appendix C: Basic VSWI edit process flowchart 
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